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WirelessKeyView v1.50 - Recover lost wireless network key
Copyright (c) 2006 - 2012 Nir Sofer

Related Links

Windows Password Recovery Tools
Password Storage Locations For Popular Windows Applications
RouterPassView - Recover ISP password from the config file of the router.
WirelessKeyView Frequently Asked Questions
WirelessNetView - Wireless Network Monitoring Software.
ProduKey - Recover lost product key (CD-Key) of Windows/MS-Office/SQL Server

See Also

NK2Edit - Edit, merge and fix the AutoComplete files (.NK2) of Microsoft Outlook.

Description

WirelessKeyView recovers all wireless network security keys/passwords (WEP/WPA) stored in your computer by
the 'Wireless Zero Configuration' service of Windows XP and by the 'WLAN AutoConfig' service of Windows Vista.
It allows you to easily save all keys to text/html/xml file, or copy a single key to the clipboard.

Search for other utilities in NirSoft

 Search

License

This utility is released as freeware. You are allowed to freely distribute this utility via floppy disk, CD-ROM,
Internet, or in any other way, as long as you don't charge anything for this. If you distribute this utility, you must
include all files in the distribution package, without any modification !
Be aware that selling this utility as a part of a software package is not allowed !

Disclaimer

The software is provided "AS IS" without any warranty, either expressed or implied, including, but not limited to,
the implied warranties of merchantability and fitness for a particular purpose. The author will not be liable for any
special, incidental, consequential or indirect damages due to loss of data or any other reason.

Known Problems

  

Network Management Tool
For LAN, WAN & Datacenters. Agentless, deploys quick. Free try!

OpManager.ManageEngine.com
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False Alert Problems: Some Antivirus programs detect WirelessKeyView utility as infected with Trojan/Virus. Click
here to read more about false alerts in Antivirus programs.

Also, if you have any problem with using WirelessKeyView, please read the WirelessKeyView Frequently Asked
Questions page

Versions History

Version 1.50:
Added export and import feature. You can now select one or more wireless keys, export them into a file
(with File -> Export Selected Items or Ctrl+E) and then import these keys into another computer (With
File -> Import Keys From Export File or Ctrl+I). Be aware that the import feature only works with
Windows XP/SP3 or later (including Windows 2008/7/Vista). The export feature works on every system
starting from Windows XP/SP1. Read the 'Export And Import Wireless Keys' section for more
information about this new feature.
Added 3 new columns, only for Windows 7/2008/Vista: Authentication, Encryption, Connection Type
(ESS for infrastructure network, IBSS for ad-hoc network).

Version 1.36:
Fixed bug on Windows 7/2008/Vista: WirelessKeyView truncated the key after 32 characters.

Version 1.35:
Added 'Mark Odd/Even Rows' option, under the View menu. When it's turned on, the odd and even
rows are displayed in different color, to make it easier to read a single line.
Added 'Add Header Line To CSV/Tab-Delimited File' option. When this option is turned on, the column
names are added as the first line when you export to csv or tab-delimited file.

Version 1.34:
Fixed bug: pressing the delete key in the find window deleted an item in the main window.

Version 1.33:
When loading WirelessKeyView under Windows 7 in the first time, the 'Code Inject' mode is now
turned on by default.

Version 1.32:
Added /codeinject command-line option.

Version 1.31:
Fixed a crash problem with Application Compatibility Engine on Windows 7/Vista (only when 'Use
code injection method' is turned on).

Version 1.30:
Added 'Use code injection method' option in the Advanced Options window, as a workaround for using
this utility on Windows 7. (See below)

Version 1.28:
Added sorting command-line options.

Version 1.27:
Fixed bug: In Vista, WPA-PSK keys in Ascii form displayed additional space character.

Version 1.26:
Fixed bug: In Vista, if WPA-PSK key contained 32 characters, the key was not displayed in Ascii form.

Version 1.25:
New and safer method to extract the wireless keys of the local machine: In previous versions,
WirelessKeyView injected code into lsass.exe in order to grab the wireless keys from the system. In rare
cases, this technique caused a crash inside lsass.exe process. Starting from this version,
WirelessKeyView uses a new method that extract the wireless keys without any code injection.

Version 1.20:
WirelessKeyView now allows you to extract the wireless keys from external instance of Windows XP.
(In Advanced Options)

Version 1.18:
You can now send the information to stdout by specifying an empty filename ("") in the command-line.
(For example: WirelessKeyView.exe /stab "" >> c:\temp\keys.txt)

Version 1.17:
Fixed bug: WirelessKeyView failed to find the adapter name
Fixed bug: Bad color in HTML report
Fixed bug: The main window lost the focus when the user switched to another application and then
returned back to WirelessKeyView.

Version 1.16 - Added support for saving as comma-delimited file.
Version 1.15 - Added support for deleting the wireless keys of old network adapters.
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Version 1.13 - Under Vista, this utility now runs as admin automatically. You don't have to explicitly choose
the "Run As Administrator" option.
Version 1.12 - The configuration is now saved to a file instead of the Registry.
Version 1.11 - Fixed 'Access Violation' problem under some wireless cards.
Version 1.10 - Added support for Windows Vista. (both 32-bit and x64 versions)
Version 1.00 - First release.

System Requirement

Windows XP with SP1 or greater.
You must login to windows with admin user.

Using WirelessKeyView

WirelessKeyView doesn't require any installation process or additional DLL files. Just copy the executable file
(WirelessKeyView.exe) to any folder you like, and run it.
After you run it, the main window should displayed all WEP/WPA keys stored in your computer by Windows
'Wireless Zero Configuration' service. For WEP keys, the key is also displayed in Ascii form. Be aware that this
utility can only reveal the network keys stored by Windows operating system. It cannot recover network keys stored
by any other third-party software.

Notice About WPA-PSK Keys

When you type a WPA-PSK key in Windows XP, the characters that you type are automatically converted into a
new binary key that contains 32 bytes (64 Hexadecimal digits). This binary key cannot instantly be converted back
to the original key that you typed, but you can still use it for connecting the wireless network exactly like the
original key. In this case, WirelessKeyView displays this binary key in the Hex key column, but it doesn't display the
original key that you typed.
As opposed to Windows XP, Windows Vista doesn't convert the WPA-PSK Key that you type into a new binary key,
but it simply keep the original key that you type. So under Windows Vista, the original WPA-PSK key that you
typed is displayed in the Ascii key column.

Registry/File Location of The Stored Keys

Windows XP and Windows Vista stores the wireless keys in completely different locations:

Windows XP: The wireless keys are stored in the Registry under HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\WZCSVC\Parameters\Interfaces\[Interface Guid].
Windows Vista: The wireless keys are stored in the file system, under c:\ProgramData\Microsoft\Wlansvc
\Profiles\Interfaces\[Interface Guid]. The encrypted keys are stored in .xml file.

Deleting Wireless Keys Of Old Network Adapters

Starting from version 1.15 of WirelessKeyView, you can delete wireless keys/passwords of old network adapters
that are no longer plugged to your computer, by using the 'Delete Selected Items' option.
Be aware that this delete option only works for network adapters that are not active anymore. If your network
adapter is active, use the standard user interface of Windows to delete the unwanted keys.

Using this utility on Windows 7

Starting from Windows 7, Microsoft changed the encryption and hashing algorithms that are used by the Windows
Data Protection (DPAPI) system. This change also affects the encryption of the wireless keys stored by Windows,
and thus WirelessKeyView failed to retrieve the wireless keys under Windows 7.
The research and development of a new code that will decrypt the keys of Windows 7 may take a while. So for now,
I added a workaround that will allow Windows 7 users to retrieve their wireless keys. This workaround uses an old
method of code infection that I used until version 1.25 and it still works properly under Windows 7. This method has
one drawback that you should be aware: In some circumstances, it may crash the lsass.exe process and will require
your system to restart.
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In order to use this code injection method under Windows 7, go to 'Advanced Options' (F9), and choose the 'Use
code injection method' option.

Export And Import Wireless Keys

Starting from version 1.50, you can select one or more wireless keys, export them into a text file by using the 'Export
Selected Items' under the File menu, and then import these keys into another computer by using the 'Import Keys
From Export File' option.

Before you start using this feature, you should be aware that there are some problems/limitations:

The import feature only works on Windows XP with Service Pack 3 or later, including Windows 7, Windows
2008, and Windows Vista. You cannot use the import feature on Windows XP with Service Pack 1 or Service
Pack 2. As opposed to the import feature, the export feature works on any system, including Windows XP
with Service Pack 1 or Service Pack 2.
The import feature on Windows XP/SP3 is very slow, and WirelessKeyView may temporary hang during the
import process.
The wireless keys stored inside the export file are not encrypted, so if you're concerned about the security of
your network, you should keep this file in a place where unauthorized users cannot read it, or simply delete it
after the import process is finished.
The import feature only works with a text file created with the 'Export Selected Items' option. You cannot use
the import feature with the files created by the 'Save Selected Items' option.
Your wireless network adapter must be active when using the import feature. If you have a USB wireless
adapter, you must plug it before you start the import process.
If you have multiple wireless network adapters, a separated key entry will be added for each adapter.

Command-Line Options

/external <Windows Directory> Load the wireless keys from external instance of Windows XP.

/codeinject <0 | 1> Specifies whether the use the code inject method. 1 = yes, 0 = no.

/stext <Filename> Save the list of all wireless keys into a regular text file.

/stab <Filename> Save the list of all wireless keys into a tab-delimited text file.

/stabular <Filename> Save the list of all wireless keys into a tabular text file.

/shtml <Filename> Save the list of all wireless keys into HTML file (Horizontal).

/sverhtml <Filename> Save the list of all wireless keys into HTML file (Vertical).

/sxml <Filename> Save the list of all wireless keys to XML file.

/sort <column>

This command-line option can be used with other save options for sorting by
the desired column. If you don't specify this option, the list is sorted according
to the last sort that you made from the user interface. The <column> parameter
can specify the column index (0 for the first column, 1 for the second column,
and so on) or the name of the column, like "Key Type" and "Network Name".
You can specify the '~' prefix character (e.g: "~Network Name") if you want to
sort in descending order. You can put multiple /sort in the command-line if you
want to sort by multiple columns.

Examples:
WirelessKeyView.exe /shtml "f:\temp\1.html" /sort 2 /sort ~1
WirelessKeyView.exe /shtml "f:\temp\1.html" /sort "Network Name"

/nosort When you specify this command-line option, the list will be saved without any
sorting.

Translating WirelessKeyView to other languages
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In order to translate WirelessKeyView to other language, follow the instructions below:

Run WirelessKeyView with /savelangfile parameter:
WirelessKeyView.exe /savelangfile
A file named WirelessKeyView_lng.ini will be created in the folder of WirelessKeyView utility.

1.

Open the created language file in Notepad or in any other text editor.2.
Translate all string entries to the desired language. Optionally, you can also add your name and/or a link to
your Web site. (TranslatorName and TranslatorURL values) If you add this information, it'll be used in the
'About' window.

3.

After you finish the translation, Run WirelessKeyView, and all translated strings will be loaded from the
language file.
If you want to run WirelessKeyView without the translation, simply rename the language file, or move it to
another folder.

4.

Feedback

If you have any problem, suggestion, comment, or you found a bug in my utility, you can send a message to
nirsofer@yahoo.com. If you have a problem, please read the WirelessKeyView Frequently Asked Questions page
and the general Frequently Asked Questions page before sending an email.

Download WirelessKeyView

Download WirelessKeyView for x64

***** WirelessKeyView Frequently Asked Questions *****

Go To Password Recovery Tools Page

 
 

 
WirelessKeyView is also available in other languages. In order to change the language of WirelessKeyView,
download the appropriate language zip file, extract the 'wirelesskeyview_lng.ini', and put it in the same folder that
you Installed WirelessKeyView utility.

Language Translated By Date Version

Arabic Abo Rehaam 22/04/2011 1.35

Brazilian Portuguese Dimas Silva 18/06/2010  

Brazilian Portuguese SoftDownload 23/09/2011 1.36

Bulgarian Àëåêñàíäúð Äè÷åâ 26/06/2008  

Croatian Ivan Grubišiæ 20/02/2012  

Download Network Sniffer
Advanced Network Monitoring Tool. Windows

Software. Download now.
www.Paessler.com/network_sniffing
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Czech Buchtiè 11/08/2011  

Danish Tajs P. Nielsen 13/11/2008  

Dutch Jan Verheijen 02/05/2012 1.50

Dutch J. Kramer 27/07/2008  

Finnish  26/04/2012  

French Jean-Michel Gillion 04/05/2008  

French PasswordOne 18/06/2012  

French papoo 20/02/2010 1.33

Galician Xosé Antón Vicente Rodríguez 05/07/2008  

German «Latino» auf WinTotal.de 30/04/2012 1.50

Greek Èåïäþñïõ Ãéþñãïò 19/05/2007  

Hebrew peterg 29/04/2011  

Hungarian Tamás Ferenc 09/07/2011 1.35

Italian Fabio Milocco 14/05/2011 1.35

Japanese iLEƒÖEj 01/05/2012 1.50

Korean oborodokio 14/09/2011 1.36

Macedonian SaLt 13/08/2008  

Norwegian jtf 30/06/2008  

Norwegian Colargol66 26/06/2008  

Norwegian Rolf Hennum 21/10/2008  

Polish Lanpolis.pl 25/11/2008  

Polish localizr.net 17/12/2008  

Portuguese Carlos Dias (Ovar) 15/03/2008  

Romanian Jaff (Oprea Nicolae) 01/05/2012 1.50

Russian Kvark && Dm.Yerokhin 30/04/2012 1.50

Simplified Chinese renda 12/03/2009  

Simplified Chinese Lechie 20/04/2011  

Simplified Chinese Zhe Yao 19/07/2011  

Slovak maros336 28/02/2010 1.27

Spanish Rabanero 10/01/2009  

Swedish WSDN Wictor Winsnes 02/12/2006  

Taiwanese Republic of Taiwan 07/03/2007  

Traditional Chinese ¤¦·¬(¦ä¤G¹q®ð¶E©Ò) 05/05/2012  

WirelessKeyView: Recover lost WEP/WPA key/password store... http://www.nirsoft.net/utils/wireless_key.html

6 of 7 6/29/12 1:08 PM



Thai K.Chaisingthong 28/12/2007  

Turkish HARUN ARI 01/10/2011 1.36

Valencian vjatv 06/01/2008  
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